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Editing Transitions

Changing the Look of Transitions  

In MoviePack different effects can be applied to individual clips to
change their appearance, and the same is true for transitions. 

You can also use the ready-made transitions from the extensive range of
transitions copied to your hard disk during installation. 

In this booklet you will learn how to create and modify your own
transitions. 

Our Aim  This booklet will teach you how to: 

● Alter existing transitions

● Create new transitions
Manual Tutorial Reference Effects
Editing Transitions
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In a few easy steps you will learn how to make new transitions. 

I Please read the ’Tutorial - The Interface’ booklet before
beginning ’Tutorial - Video Editing’ as the MoviePack
interface described therein is needed for the following
tutorial. 

Preparing a New 
Animation 

A new animation is also needed in the Canvas window.

u Close any existing animations with the Close command from
the File menu (shortcut Ctrl+F4). 

Save the animation under a suitable name in a suitable folder. 

Each new animation has to be set up properly. The size of the animation
should be 320 x 240 pixels with 25 frames per second set against a
white background. 

u Click the  New Animation icon in the MoviePack icon bar.

u In the Animation Setup dialog box in the Time tab select PAL (or
NTSC).

u In the Page tab select Size Multimedia Medium, 320 x 240.

u Click Background Color.

u In the Choose Color dialog box set the Brightness slider to 100 in
HSB or in the chromaticity diagram drag the small slider to
the white area.

I In the Schemes tab you can save the settings under ’PAL-
Medium-White’ and then all new animations will be loaded
with these settings in future.

Adjust the new Canvas, ’Animation x’, to full size by dragging the corners
of the window. 
Editing Transitions
Transitions TUT 5Manual Tutorial Reference Effects
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Changing Existing Transiti-
ons  

Take a look at existing transitions to get
an idea of the many possibile ways to
animate your videos and to get a feeling
for the transitions.  

u In the Browser click Generated
Transition [PAL Transitions] or
Generated Transition [NTSC
Transitions].

You now have access to all the pre-made
transitions which were copied to the
’Transitions’ folder during installation.

Integrating Transitions Let’s take a look at a simple but extremely useful example.

u In the Generated Transition [PAL Transitions] tab double-click the
'Transparency.M3T' transition.

The activated transition is inserted into the transition track of the Timeline
to the right of the Timeslider. The length of the transition and the preview
area is the standard 3 seconds.  

Neither the Canvas nor the Preview show any changes because there is no
object. 

tut_transitions_031_x.tif
Tut_Transparency:001.m3w 

Transitions can be inserted only into the Transitition track in the Timeline. 

Preview Area

Tut_Transitions_Timeline_00
1_G.tif
Tut_Transparency:001.m3w 
Manual Tutorial Reference Effects
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Drag the Timeslider to a different time in the Timeline or Preview and in
the preview window of the Effect Box the changes to the transition can be
seen.  

A disappears slowly and is replaced by B (gradual transition).

I The letter A represents the clip in the Video A track and B
represents the clip in the Video B track.

ï The Timeslider in the Effect Box should not be moved. It will be
used to manipulate effects, as described in the ’Tutorial -
Animations’ booklet.

If the switch Exchange A and B sources is switched on, this process is
reversed: The B disappears slowly and is replaced by A. 

u In the Effect Box turn the switch Exchange A and B sources On and
Off alternately.

u In the Timeline move the Timeslider.

u In the Effect Box observe the changes. 

In the preview window of the Effect Box the transition from the clip in Video A 
to the clip in Video B is represented by a frame. The time can be altered 
using the Timeslider in the Timeline or in the Preview window.

Transition-Symbol Path and name of highlighted transition.
Tut_Transitions_Effectbox_00
1_E.tif
Tut_Transitions_Effectbox_00
2_E.tif 
Tut_Transparency_001.m3w 
Editing Transitions
Transitions TUT 7Manual Tutorial Reference Effects



   

8

Opening Transitions  As with objects, different effects can be applied to transitions. To see
which effect has been used and which parameters have been altered,
the transition has to be opened. 

u In the Timeline, double-click the ’Transparency.M3T’ transition
to open it.

Transition Mode  The Canvas and the Timeline change from animation mode into transition
mode. 

I In the Canvas window the transition icon  appears before
the title. 

The Canvas containing the transition lies on top of the Canvas containing
the animation and can now be adjusted.

In the Timeline both the A and B sources are displayed as two separate
objects in their own tracks. 

The Effect Box displays the active source when the Timeslider is positioned
over it. 

In the Preview window the first frame of the transition is visible. 

u Press Play  in the Preview window. 

The ’symbolic’ preview of the transition can be seen - the gradual
transition from A to B, but A and B do not move.
Manual Tutorial Reference Effects
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The transition can be analysed and altered.  

How was the 'Transparency.M3T' transition made? Let’s take a look at
the sources one after the other. 

u In the Timeline, click on the top Source A. 

The Canvas and the Timeline have been switched from animation mode into transition mode. It is obvious which effect 
has been applied to the Sources A and B in the Effect Box.

Tut_Transitions_001_E.tif 
Tut_Transparency_002.m3w
Editing Transitions
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Effect Box  The icon bar of the Effect Box contains the icons for Source A, for
Transformations and for the Transparency effect from the Alpha Processing effect
group.  

As no Transformations have been made A does not move. 

Let’s take a closer look at the Transparency effect in the Effect Box.

u In the Effect Box, click the Transparency icon.

u In the Timeline, move the Timeslider.

u In the Effect Box, observe the changes.  

In the Effect Box the slider of the only parameter, Transparency, moves in
proportion to the time change. At the beginning Source A is not
transparent - only the A is visible. Towards the end Source A becomes
more and more transparent until it disappears and is no longer visible.

OK, but what happens to B?

u In the Timeline, click the bottom Source B. 

The icon bar of the Effect Box only contains the icons for Source B and the
Transformations. No Transformations have been made so B does not move. 

Source Transformations Transparency

Tut_Transitions_Effectb
ox_003_E.tif
Tut_Transparency_001.
M3W 
Manual Tutorial Reference Effects
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The behavior of the ’Transparency.M3T’ transition is due to the
transparency of Source A.  

I The ’Transparency.M3T’ transition is a universally applicable
transition for videos and slide shows. 

Altering Transitions  We can make the transition more interesting. In addition to the
transparency of the Source A we could also make Source B move, for
example from right to left. 

u In the Timeline, click the Source B. 

u Set the Timeslider to 0:00:00:00. 

u Enlarge the Canvas window. 

u Zoom the Canvas and move it until there is enough room to
move Source B. 

In the effect Transparency, the parameter Transparency alone controls the gra-
dual transition from Source A to Source B. 

Tut_Transitions_Preview_011
_E.tif 
bis ....014_E.tif
Tut_Transparency_001.M3W 
Editing Transitions
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The transition can now be easily editied.  

Although Source B is activated in the Timeline, the A appears in the Canvas
along with its object borders and their 8 handles. This is because
Source A is not transparent at the beginning of the transition and the
sources are placed exactly on top of one another. 

The Canvas window fills all the free space between the windows.
The actual Canvas remains the proper size but is moved to the left using the 
scroll bars so there is enough space next to it for Source B to be moved 
around. 
The Canvas can be centered later on using the Center button. 

Tut_Transitions_002_E.tif 
Tut_Transparency.M3W 

Zoom Move Center
Manual Tutorial Reference Effects
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u In the Canvas, click the center of the source and drag it to the
right until the border reaches the edge of the Canvas 

I While moving the object only the borders move and not the
whole object. Next to the center point the current position of
the object is displayed. 

After moving the object you will realize that in fact it was not the visible
Source A, rather the activated Source B that has been moved. It looked like
Source A was active in the Canvas because Source B lies exactly under Source
A and they are exactly the same size.

Source B now lies next to Source A.
In the Effect Box the position of B
can be corrected numerically to
the X: 320 und Y: 0 in the
Position tab of Transformations. 

The results of the manipulations
are visible in the Preview.

In the Canvas an active object is moved using the mouse.

Former center 
of the object

Object borders

New center 
indicating the 
position in the 
Canvas

Handles

Tut_Transitions_Canvas_001_
X.tif 
Tut_Transparency_001.M3W  
Editing Transitions
Transitions TUT 13Manual Tutorial Reference Effects



   

14
u Press Play  in the Preview. 

In the Preview both sources A and B are displayed. A slowly becomes
invisible and B moves from right to left underneath A.  

You get a much better idea of the altered transition if you use an image
or video source. 

Now save the transition under a suitable name. 

u From the File menu, select Save as.

u In the Save File dialog box enter a suitable name
(e.g. ’Tut_Transparency_Move.M3T’) and select or create a
suitable folder.

u Click Save. 

Animation Mode The transition has now been saved and you can return to animation
mode.

u Minimize the Canvas window containing the transition or
move it and click the window containing the animation.

or

u From the Window menu select the window with the open
animation.

I In the Canvas window the MoviePack icon  appears before
the title. 

Move the Timeslider in the Timeline so you can see the altered behavior
of the transition in the Effect Box preview.

How does the transition work with sources? Among the examples in the
’Samples’ folder you will find a few photos with exotic motifs.

u In the Browser, activate the Still Image [Samples] tab. 

u In the Browser, scroll down until the thumbnails for the images
’PA038_L.JPG’ and ’PA034_L.JPG’ are visible.

u Drag the ’PA038_L.JPG’ image into the Video A track in the
Timeline so that the black object bar begins at 0:00:00:00.
Manual Tutorial Reference Effects
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For the transition to the second clip, select a similar motif.

u Drag the ’PA034_L.JPG’ image into the Video B track in the
Timeline so that the black object bar begins at 0:00:01:00.

The position and duration of the transition must be adjusted to the
sources. 

u Click the ’Tut_Transparency_Move.M3T’ transition in the
Timeline and move it in the track until it begins with the source
in Video B and ends with the source in Video A. 

The Timeline will be arranged like this: 

Both images overlap for 2 seconds and between them lies the edited
transition. In the Preview you can see how the first photo slowly fades out
and the second one comes into focus. 

Do you want the second photo to be visible sooner? No problem, the
transition can be changed quickly.

u In the Timeline, double-click the transition. 

MoviePack switches back into the transition mode.

u In the Timeline, click the Source B. 

u In the Timeline, set the Timeslider to 0:00:00:00.

u In the Effect Box click the Position tab of Transformations.

u Correct the position to X: 160 and Y: 0. 

Tut_Transitions_Timeline_00
3_G.tif
Tut_Transparency_001.M3W
Editing Transitions
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Take a quick look at the Preview to see the results: At the beginning of
the transition Source B is half visible under the faded Source A. 

By moving Source B even more the animation really comes to life. 

Tut_Transitions_Preview_015
_E.tif ff. 
Tut_Transparency_001.M3W 
Manual Tutorial Reference Effects
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The result are clearer if you switch to animation mode. You will see that
the transition has become smoother. 

The animation is saved under ’Tut_Transparency.M3’ and
’Tut_Transparency_Move.M3’ in the ’Samples’ folder and
can be used for further experiments with transitions.   

Tut_Transitions_003_E.tif
Tut_Transitions_004_E.tif
Tut_Transparency_Move.M3W 

To see how a transition with footage really looks you have to switch to the 
animation mode. 
In the transition mode all the effects and transformations are selected. 
Editing Transitions
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Creating New Transitions

Effective Transitions make Animations more Interesting  

From OLD to NEW  Let’s have another look at the simple 'Transparency.M3T' transition,
which contains just the one effect, Transparency. If you replace this effect
with another you will create a new transition. 

u Save and close existing animations. 

u From the File menu select Open to open the animation
'Tut_Transparency.M3' from 'Samples'. 

I Shortcut Ctrl + O and the icon Open  can also be used to
activate the Open dialog box.

We are going to delete the Transparency effect from
'Tut_Transparency.M3T' to remove the gradual transition. 

u In the Timeline double-click the transition to open it.

MoviePack switches to transition mode.

u In the Timeline click the Source A. 
Manual Tutorial Reference Effects
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Source A appears in the Effect Box and the 3 icons, Source, Transformations
and Transparency, appear in the icon bar.

u In the Effect Box icon bar, click the icon or the Transparency
effect and delete using the Del key.

u Allow the Preview to run and switch alternately between the
Canvas with the transition and the Canvas with the animation
while watching the Preview.

Nothing happens in the Preview of the transition or the Preview of the
animation because the Transparency effect has been deleted. In the
animation you will see a so-called hard cut at 0:00:03:00.

Dropping Wave Effect  For the new transition select a 3D effect from the many effects available.
Dropping Wave is a concentric wave similar to the ripple effect when a
stone is thrown in water.

u In transition mode click the Source A. 

u In the Browser, click the Effects tab.

u In the Effects folder double-click  3D FX. 

u In the 3D FX folder click the icon  Dropping Wave and drag
it onto the Source A in the Timeline. 

In the Effect Box we can see
several effect parameters for
Dropping Wave.  

In addition to the Amplitude and
the Dissipation of the wave, we
can also alter its Radius, Center
and Phase.

Tut_Transitions_Effectbox_00
4_E.tif 
Tut_DroppingWave_001.m3w
Creating New Transitions
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In the Timeline, move the Timeslider from the beginning to the end of the
transition. No parameter changes are noticeable in the Effect Box. Source
A ripples slightly over the entire time span.

The transition should in fact begin without any deformation of Source A,
therefore the Amplitude parameter must be reset.

u In the Timeline, set the Timeslider to 0:00:00:00.

u In the Effect Box, set the slider of the parameter Amplitude to 0. 

The transition begins without any alteration of Source A. The deformation
is only very slight when the Amplitude is increased from 0 at the
beginning to 20 at the end of the transition.   

Further experiments using various values for the Amplitude and other
parameters, for example Dissipation, bring us closer to more exciting
results.

u In the Timeline, set the Timeslider to 0:00:03:00.

u In the Effect Box, change the Amplitude parameter from 20 to
50. 

As the Amplitude increases from 0 to 20, A is only slightly deformed. 

Tut_Transitions_Preview_00
1_E.tif 
Tut_DroppingWave_001.m3
w

Manual Tutorial Reference Effects
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u In the Effect Box, change the Dissipation parameter from 50 to 0.

A is very deformed at the end of the transition. 

Now we are going to make the A disappear at the end of the transition. 

u In the Effect Box, click the Transformations icon.

u In the Scale tab, change the Scale parameter from 1 to 0.2. 

u In the Timeline, set the Timeslider to 0:00:02:00.

u In the Scale tab, reset the Scale parameter to 1. 

At the beginning A remains the same size but starts to deform and it
gradually gets smaller as it continues to deform. 

Take a look at the results in the Preview (in transition mode and in
animation mode).

u Press Play  in the Preview. 

u Switch from transition mode to animation mode. 

u Press Play  in the Preview. 

The altered Amplitude and Dissipation values of the Dropping Wave result in a 
definite deformation.

Tut_Transitions_Preview_004_
tif Tut_DroppingWave_001.m3
Creating New Transitions
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Transparent Border Effect  Perhaps you have the impression that while watching the Preview the
sharp edge of the first image interferes with the transition and should be
replaced by a softer edge.

To put the finishing touches to the transition we are going to apply a
Stylize effect. The Transparent Border effect will gradually make a part of the
clip’s border transparent.

u Switch from animation mode to transition mode.

u In the Timeline, click Source A.

u In the Browser, click the 3D FX tab. 

u Using the Level Up icon  move up one level from the 3D FX
to the Effects. 

u In the Effects folder, double click the Stylize effect group .

u In the Stylize folder, click the Transparent Border icon and
drag it onto Source A in the Timeline. 

A fourth icon appears in the
Effect Box icon bar.   

The Transparent Border effect has
only one parameter, the Border
Width, and one switch, Equal
Borders.

At the beginning of this effect set the Border Width to 0.

u In the Timeline, set the Timeslider to 0:00:00:00. 

u In the Effect Box, drag the Border Width slider to 0. 

When the effect is activated the Border Width is automatically set to 10 at
the end of the transition and we can see in the transition preview how
the Source A borders gradually become transparent. The animation
preview now looks much better. 

Tut_Transitions_Effectbox_0
05_E.tif
Tut_DroppingWave_001.m3
w

Manual Tutorial Reference Effects
Creating New Transitions
Transitions TUT



   
With a Border Width of 20 at the end of the transition the transparent
border becomes thicker and the four corners of Source A disappear as it
becomes smaller.   

The animation is saved under ’Tut_DroppingWave.M3’ and
the transition under ’Tut_DroppingWave.M3T’ in the
’Samples’ folder and can be used for further experiments
with transitions.   

Transitions without LimitsWe have simply applied the transformations and two of the numerous
effects available in MoviePack to a transition source and altered a few
parameters for the animation. 

The transformations alone enable you to create simple but interesting
and varied transitions, for example, Source A could be made smaller,
rotated, flapped to the side and moved, while Source B could be
enlarged and allowed to flutter. 

Source A with and without transparent border. The transparency ensures a 
smoother and more successful transition from A to B.

Tut_Transitions_Preview_007
_E.tif
Tut_DroppingWave_001.m3w

Tut_DroppingWave.M3
Tut_DroppingWave.M3T

Tut_Transitions_011_X.tif bis 
15 
Tut_TransitionTransformation
s.M3T

A few mouse clicks not only allow you to select, move, reduce, enlarge 
and rotate a source but also to conjure up varied transitions without using 
one single effect.
Creating New Transitions
Transitions TUT 23Manual Tutorial Reference Effects



   

24
You will soon realize that adding one or more effects to one or both of
the sources creates an infinite sphere of activity for the creative video
animator.  

Save your successful transition experiments under a suitable
name in a separate folder so that you can use them again
later in the animation.  

Creating New Transitions  You do not necessarily have to delete existing effects in an existing
transition to create a new transition. 

Each new animation has to be set up properly. The size of the animation
should be 320 x 240 pixels with 25 frames per second set against a
white background. 

u Click the  New Transition icon in the MoviePack icon bar.

The New dialog box is opened.

u As when creating a new animation (see the ’Tutorial - The
Interface’ booklet) set the standard in the Video System tab to
PAL (or NTSC) in the Animation Setup dialog box.

u In the Page tab, select Size Multimedia Medium, 320 x 240.

u Click Background Color.

u In the Choose Color dialog box set the Brightness slider to 100 in
HSB or in the chromaticity diagram drag the small slider to
the white area.
Manual Tutorial Reference Effects
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I If the settings are saved in a scheme ’PAL-Medium-White’,
new animations can be loaded with these settings (schemes)
from the Schemes tab.  

A new empty transition will be created if you follow these steps. Only
the icons for Source A and B and the Transformations are visible in the Effect
Box. Any movement from the Transformations and any effect from the effect
folders in the Browser can now be applied to each source. 

Tut_Transitions_004_E.tif
Tut_TransitionNew.m3w
Creating New Transitions
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Trying Out Different Transi-
tions  

You can now use, discover, change and adapt the many existing
transitions found on the MoviePack CD to suit your tastes and video
material. Remember that a successful transition from one clip to the next
will not necessarily work for all clips. Creating transitions should now
be child’s play! 

ï MoviePack gives your creativity free reign. 
Manual Tutorial Reference Effects
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